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Introduction

He would keep on trying to do this or that with a grim persistence that

was painful to watch . . .

John Wyndham, ‘The Day of the Triffids’1

Maple is a computer program capable of performing a wide variety of

mathematical operations. It originated in the early 1980s as a computer

algebra system, but today this description doesn’t really do it justice.

Maple has facilities for algebra, calculus, linear algebra, graphics (two-

and three-dimensional plots, and animations), numerical calculations

to arbitrary precision, and many other things besides. It is widely used

in universities across the world, and is particularly useful for tasks

that are tedious and error-prone when performed by humans, such as

manipulating complicated series expansions and solving large sets of

simultaneous equations. Used correctly, Maple can save time and quickly

solve problems that would otherwise be intractable. Used incorrectly, it

can lead to frustration, and the destruction of expensive IT equipment.

At the time of writing, the current version is Maple 2016. Versions

before Maple 2015 were numbered starting from 1; the last of these

was Maple 18. New features introduced in each version from Maple 4.0

onwards can be viewed using the help system (see Section 2.2). For the

most part, recent changes have been relatively minor, at least as far as

the material in this book is concerned. Consequently, all of the examples

work with both Maple 2015 and Maple 2016. In fact, most will work

in older versions as well, though naturally the number of exceptions

increases the further back one goes. Two substantial new features are

the dataplot command, discussed in Section 6.6, and the new rules

concerning terminating characters, described in Appendix B (see also

Section 2.3). Both of these were introduced in Maple 2015.

1 Penguin Books, 1954. Reprinted by permission of Pollinger Limited
(www.pollingerltd.com) on behalf of the Estate of John Wyndham.
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2 Introduction

1.1 Why This Book?

This book is intended for students, teachers and researchers who will

ultimately wish to use Maple for advanced applications. Here, ‘advanced’

means something more complex than evaluating a single integral, but

not necessarily designing and running a simulation of the latest jet

engine. The book is suitable for undergraduates and postgraduates taking

a course in which Maple is used, and for researchers who intend to

use Maple for part of their work. It can also serve as a consolidation

guide for users who already have some knowledge of Maple, but find

themselves unable to decipher and eliminate certain error messages, or

who currently rely on apparently magic recipes for solving problems,

based on commands or operations whose meaning is not clear. There

is no reliance on magic recipes here. Every feature we use is properly

explained, with references to the online documentation where appropriate.

The book is not a comprehensive reference guide (already available via

the help system; see Section 2.2), nor is it a beginner’s guide in the

normal sense. It most certainly is not a ‘guide for dummies’. We start from

the beginning, assuming no prior knowledge of the subject whatsoever,

but where advanced topics are central to understanding Maple they are

tackled head-on, even as early as Chapter 2. In particular, the evaluation

rules are a regular feature throughout. These determine the order in

which input is processed by Maple. In most circumstances they are fairly

simple (Section 8.4 discusses some more complex situations), but they

are absolutely crucial.

Using this book, it is possible to tackle many complex problems without

any additional Maple documentation. Readers can quickly progress to

using packages and commands that have not been discussed, because the

principles introduced apply across the whole system. Where the book

alone is not sufficient, those who have read it will find themselves able

to fully understand Maple’s help pages, which can be rather technical,

and the Maple Programming Guide (see Section 2.2), which is squarely

aimed at very advanced users.
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1.2 The Maple Interface 3

1.2 The Maple Interface

Users may interact with Maple in several different ways. One may proceed

by typing commands, by using interface driven methods based on palettes

and context menus, or by a combination of the two. The advantages and

disadvantages of a particular method are not always obvious, though they

may be hugely significant.

Interface driven methods can be very tempting to new users, because

they may appear to eliminate the need to study a manual. For example,

with the factory setting for input (2-D Math; see Section 2.1) it doesn’t take

much effort to work out how to sum series and evaluate integrals, using

the Calculus and Expression palettes at the sides of the screen (if these are

not visible, they can be revealed by choosing Palettes ◮ Expand Docks

from the View menu). However, most users will eventually want to try

something a little more complicated, in which case things are not quite so

straightforward. For all its power, Maple is only a computer program, and

as such it can only understand mathematical input that is structured in the

correct way. Just as it is possible to type incorrect commands, it is also

possible to use the palettes incorrectly, and construct something that a

human mathematician might understand, but Maple does not. One way or

another, technical issues will sometimes arise, and a solid understanding

of Maple is needed to deal with these effectively. In view of this, interface

driven methods don’t save much time, unless the software is to be used

exclusively for solving elementary problems. There will be no further

discussion of such methods here (search for the User Manual in the help

system for more information on the subject).

This book takes a command driven, or programmatic, approach to

Maple, with the focus on the language rather than the interface. This

has two principal advantages. First, it scales up very easily: the simple

building blocks that make up the Maple language can be assembled

to solve complex problems in an efficient way. This is where the real

power of Maple lies. Second, there is transparency: a Maple worksheet

constructed using a sequence of mouse clicks and menu selections is

opaque in that a user opening it cannot see immediately (if at all) how it

was created, or how it could be modified and adapted to his/her needs.
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4 Introduction

On the other hand, a worksheet composed from typed commands is

100% transparent. It may be that some users who master the Maple

language later decide that more interface driven methods are suitable for

some or all of their work. However, such users will continue to find this

book valuable, because understanding the Maple language makes the

behaviour of its interface far more tractable.

1.3 How to Read This Book

The technical material in this book is intended to be read in order and

in its entirety. Great effort has been expended to keep the content short,

while still covering all of the key points. Time has also been spent

minimising the number of situations in which concepts are used before

they are properly introduced. In a few places, these structural aberrations

turn out to be unavoidable (or the lesser of two evils). Where this is

the case, the simplest possible examples have been used to illustrate

the issue at hand, and a reference to a later section, in which the out of

place concept is dealt with in detail, is always given. At the very least,

every reader should study Chapter 2. Most of this is very basic, but many

fundamental aspects of Maple are described here, and without knowledge

of these its behaviour can seem mysterious at best, and infuriating at

worst. Chapters 3–6 depend heavily on Chapter 2, but less so upon each

other. The majority of users will need the material in Chapters 3 and 4,

which introduce Maple’s symbolic computation facilities. Chapters 7–9

really need to be read in sequence. Without the ideas they contain, solving

some problems will necessitate tedious, repetitive work, such as entering

large numbers of very similar commands, which is not an efficient way

to use Maple.

Throughout the book, items that appear in menus or dialogue boxes

are shown in a rounded box with a grey background, such as Help .

Keystrokes such as return have a sharp-cornered box with a white

background. Icons for toolbar buttons are shown as they appear in

Maple 2016; the Maple 2015 version is also shown or described if it is

significantly different. Small blocks of text marked with the symbol⋆ are

tips. These are useful (often very useful) but not vital pieces of information
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1.3 How to Read This Book 5

or advice. In some cases it is possible to deduce them from other parts of

the book. Input and output is shown in the same style in which it appears in

Maple itself (provided the configuration process explained in Section 2.1

is followed). In particular, Maple commands and statements are shown in

a typewriter typeface. In a few places, Maple statements, or parts

thereof, have been omitted in order to illustrate a larger or more general

structure. Text in italics is used to give an indication as to what is missing.

Output is omitted if showing it requires an inordinate amount of space.

This convention is used extensively in Chapter 6, where plots drawn by

Maple are not shown.

To get the most out of the examples throughout the book, it is necessary

to execute them in Maple, and to experiment by modifying them. To

save time for readers, the relevant files have been made available for

download.2 Typing the examples manually is fine, but it may be necessary

to insert additional restart commands (see Section 2.11) between some

of them to prevent unintended interactions, especially if the ordering

is changed. The online worksheets already contain sufficient restart

commands to ensure that everything works exactly as shown. Copying

and pasting from an electronic version of the book may lead to unexpected

results, and is therefore not recommended.

Please report errors to ian.thompson@liverpool.ac.uk.

2 pcwww.liv.ac.uk/∼itho17/understanding_maple
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Getting Started

The quote is not worth two hundred dollars!

The author1

⋆ If Maple appears to freeze, try pressing the interrupt button (the

icon is a white hand inside a red stop sign in Maple 2015 and earlier)

in the worksheet toolbar at the top of the window. You may need to

wait a few seconds for this to take effect.

⋆ Due to the nature of Maple, it is not possible to entirely prevent it

from crashing. This is very rare in modern versions, but you should

still save your work frequently. In particular, the Auto save facility

under Tools ◮ Options (Mac: Maple 2016 ◮ Preferences ) should

always be enabled.

2.1 Configuring the Interface

The Maple engine, that is, the part of the software which processes data

and performs calculations, can be accessed in several different ways. By

far the most widely used is the Standard Worksheet Interface, which is

started by clicking on the Maple icon, or by issuing the terminal command

xmaple on some unix systems. It is probably fair to say that what most

users refer to as ‘Maple’ is in fact the Standard Worksheet Interface

(alongside the engine). However, there is also a Classic Worksheet

Interface for 32-bit Windows machines, which places lower demands on

system resources (in the past there was also a Classic Worksheet Interface

for 32-bit Linux, but support for these platforms ended with Maple 2015).

Finally, there is a command line version of Maple, which is useful for

batch processing, and is briefly discussed in Appendix A. Elsewhere, it is

1 Email to a representative of Pearson Education Inc.
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2.1 Configuring the Interface 7

assumed that the Standard Worksheet Interface is in use, though for the

most part this affects only menus and toolbar buttons; nearly all Maple

commands work in exactly the same way regardless of the interface.

Maple’s Standard Worksheet Interface works with files called work-

sheets (with a lower case ‘w’). Its two modes, Worksheet (with an upper

case ‘W’) and Document, are used to create different types of worksheet.

To add to the confusion, there are different ways to enter mathematical

expressions, and these can be used in either mode. With the factory

settings, mathematical input is generally expected in 2-D Math Notation.

When an expression is typed in 2-D Math Notation, Maple reformats

the input during entry, in an attempt to display mathematics as it would

normally be written. For example, typing 1 followed by / causes a

fraction to appear, and moves the cursor into the denominator. After

entering the denominator, pressing the right arrow key moves the cursor

outside the fraction (you can also use the mouse to reposition the cursor).

Exponents behave in a similar way, so the sequence of keystrokes 2 ^

x → / 3 ^ y → → produces the expression

2x

3y

and moves the cursor outside the fraction, ready for entry of the next

term. Unfortunately, the sequence of keystrokes used to construct a

complex expression is not always evident from the display. When things

go wrong (which they inevitably do in scientific computing — nobody

gets everything right at the first attempt), getting out of trouble without

deleting material and starting again can be very difficult, if it is possible at

all. Therefore 2-D Math input is not recommended. Instead, the examples

in this book are shown in Maple Notation (sometimes called 1-D Math

Input), which is somewhat simpler. When expressions are entered using

Maple Notation, Maple displays exactly what has been typed. The

choice between Document Mode and Worksheet Mode is less important,

but Maple sometimes reverts to 2-D Math input in Document Mode

(regardless of its configuration), so Worksheet Mode is recommended.

Both the File menu and the Default home page offer users the options

of opening a worksheet in either Document Mode or Worksheet Mode.

However, some methods for creating new files will automatically cause
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8 Getting Started

a worksheet to appear in the default mode, which is Document under

the factory settings. To avoid confusion, it is best to change this. The

following steps can be used to make Maple Notation and Worksheet

Mode the default options.

• ◮ On Linux or Windows, choose Options from the Tools menu.

◮ On a Mac, go to the Maple 2016 menu and select Preferences .

• Select the Display tab.

• From the menu next to Input display , choose Maple Notation .

Since there are no significant drawbacks to displaying results as they

would be written by hand, changing Output display to something

other than 2-D Math Notation is not recommended.

• Now select the Interface tab.

• From the menu next to Default format for new worksheets , select

Worksheet .

• You may also wish to turn off the Default home page, so that a blank

worksheet appears instead when Maple is started. To do this, choose

New, blank from the menu next to Open worksheet at startup .

• Click Apply Globally .

To check that this has worked, hold ctrl (Mac: cmd ) and press N

to open a new worksheet in the default mode. Now type ‘hello’. If the

settings are correct this will appear in an upright (not italic) red or reddish

brown typeface. The above process does not change the mode for any

existing worksheets, so it may be worth quitting and restarting Maple

at this point. Although the Maple language is largely independent of

the input mode, there are some differences between the syntax rules

for Maple Notation and the rules that apply to 2-D Math Notation. In

addition, some menu items, buttons and shortcut keys may behave slightly

differently in Document Mode. To be clear:

Subsequent material in this book is written under the

assumption that Worksheet Mode and Maple Notation

are in use.
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2.2 The Help System 9

It is possible to temporarily change the input mode using the worksheet

toolbar near the top of the window. Pressing Text will switch to Maple

Notation, and pressing Math will activate 2-D Math Mode (alternatively,

press F5 to toggle between the two modes). The effect of this may not

become apparent until some input is typed, though sharp-eyed users will

notice a change in the appearance of the cursor. Adjustments to the input

mode made in this way apply only in the vicinity of the current cursor

location (strictly, they apply to commands entered under the current

prompt; see Section 2.3 for more details). Elsewhere in the worksheet,

the setting made under Input display remains in force.

⋆ To convert existing material from 2-D Math Notation (or any other

form of input) into Maple Notation, highlight it, go to the Format

menu and select Convert To ◮ 1D Math Input .

⋆ Colours and other font attributes can be changed via the style man-

agement dialogue, which is accessed by choosing Styles from the

Format menu. Choose Maple Input or 2-D Output from the list

on the left of the dialogue box and then press Modify to change the

format for input or output, respectively.

2.2 The Help System

Maple has a comprehensive help system, and it is important to learn to use

this effectively. The help system can be accessed by choosing Maple Help

from the Help menu at the top of the window, or by holding ctrl (on a

Mac hold cmd instead) and pressing F1 . The help system has a clickable

table of contents and a search facility. The help pages themselves are

connected by hyperlinks, allowing users to navigate between related

topics easily. A particular help page can be loaded directly by entering a

question mark followed by the command, operator or package with which

assistance is needed. For example, entering ?plot and pressing return

displays the help page for the plot command. To access some help pages

in this way, it is necessary to specify not just a topic, but also a subtopic,

a subsubtopic and even a subsubsubtopic. For example, to find out about

the new features of Maple 2016, one can enter ?updates,Maple2016,

www.cambridge.org/9781316628140
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10 Getting Started

whereas entering ?updates,Maple2016,AdvancedMath leads directly

to details of the new advanced mathematics features. Similar syntax can

be used to show updates from as far back as Maple 8; for earlier versions

execute ?updates,v and use the list of results to the left of the help

page (here v stands for version number, not version 5, which was called

Maple V). Many of Maple’s help pages contain a lot of technical details

at the top, but there are examples at the bottom which can be cut and

pasted into your worksheet.

⋆ Examples on a help page can be displayed in either 2-D Math Notation

or Maple Notation. Press the button marked
x ^2

x2 in the context bar at

the top of the help window to toggle between the two options.

Another useful resource is the Programming Guide, which can be accessed

by executing ?ProgrammingGuide or by searching for ‘Programming

Guide’ from within the help system. The Programming Guide is intended

for advanced users. It is very thorough, and contains a lot of information

that is beyond the scope of this book.

2.3 Statements and Execution

When a new worksheet is opened (in Worksheet mode!), the cursor

appears to the right of the prompt symbol >. Here, Maple expects a

statement, a simple example of which is shown below.

> 2 + 2

Once a statement is complete, it can be executed by pressing return .

Maple then displays the result, and the cursor moves down to a new

prompt. A statement can be executed at any time by placing the cursor

on it and pressing return , so if you make a mistake it’s easy to go

back and correct it; there is no need to type anything again. In Maple 18

and earlier, statements require a terminating character, which can be a

colon or a semicolon. This requirement was relaxed in Maple 2015, but

there are still some situations in which terminating characters are needed.

To maintain backwards compatibility as far as possible, terminating

characters will be included in all subsequent examples, even when they
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